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Visual Controls uses a familiar ribbon bar interface for its commands. The commands available in the ribbon bar will change depending if you are working 
on a layout, reviewing your schedule, or creating print pages.

Interface Overview

The first time you open Visual Controls, you will have to enter your agile login and password. This is the same login and password you used to login to the 
visual-3d.com website to download the installer.

Figure 1: Visual Login

Figure 2: Ribbon Bar

Initial Set Up

Project Explorer

In the left side panel, there are two tabs, the Project explorer tab, and the Products tab.
The Project tab is used to open up designers, so you can click the schedule node to open the schedule, select a print page to open the page designer view 
keynotes or project notes in the design, access the Sequence of Operations, and access riser diagrams. Within your project you can have several designs. 
Most projects will only need one design. By default, the top level design will be open when you open a project. You can rename a design by double clicking 
its node and typing in a new name. The design name also shows up in its tab at the top of the designer area.

Using the new command, you can add a design to your project or add additional print pages.
Within a Design there are place holder nodes for Controls, Luminaires, Rooms, and Zones. You can select items within these sections to highlight the 
related entities in the designer. So you can select all instances of a particular product type this way, or check to see where you placed individual instances 
by expanding the catalog node.
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Project Explorer (Cont.)

Figure 4:Product Properties Panel

The products tab is used to add and select products to place in your layout. You will see more about the products tab in the ‘Products’ section.

On the right of the designer are Properties panel and the Display Manager. When you select an object in the designer, the instance properties are shown in 
the Properties panel. If you select several objects, shared properties will be displayed.
The properties panel is used to edit attributes of objects in your design. Select a line to edit its color, or select a product and edit its height.

Products

Properties

Figure 3: Project Explorer
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Display Manager

The Display Manager contains a Layer section that contains either the layers imported from a CAD or Visual project, as well as the default set of System 
Layers. The Display Manager also contains a set of display views that highlight different components in the design, such as Network views that highlight 
connected devices, Product Categories that color code devices by product type, Rooms to highlight differently named rooms, SOO Assignments, and color 
code nLight Air Signal Strength when applicable. By default, Solutions Designer will place different types of objects on different system layers.
If you import a PDF or image, it will be imported to its own layer within the system layers. If you import a DWG, all of its layers will be shown in its own layer 
group.
You can lock a layer by clicking the pencil icon, click it again to hide the layer. You can set the layer a color, or set it to color by entity by selecting the color 
icon. Settings made on layer groups cascade to all child layers.
Use the add button to create a new layer. Local layers can only be used with the design on which they were added. Global layers, however, are visible on 
every design in the project. The new layer will be made active as indicated with a green dot to the left of the layer name. When a layer is active, all entities 
you create will be placed on the active layer. To change what layer is active double click the layer name. If you make any system layer active the top level 
‘System Layers’ will highlight as active and created entities will be placed automatically on to their system layer.
To rename a user layer, click its label twice, or select it and right click ‘rename’. If you delete a layer, it will delete the layer, any child layers below it, and all 
associated objects.
You can change what layer an entity is on by selecting it, then changing its layer in properties.
User layers allow you to change the color of entities, for example, place all switch on one layer that is green, or all emergency products on a layer that is red. 
You may also change the color of products by editing their symbols and setting the layer color mode to ‘By Entity’.

Figure 5: Display Manager

Figure 6: Design Tool Bar

At the top of the designer is a HUD toolbar. On the left there are common camera commands like zoom all, and zoom in/out. In the middle you will find 
your snap settings. On the right, are the selection filters.

Design Environment



7 of 45Acuity Brands | One Lithonia Way Conyers, GA 30012  Phone: 800.535.2465   www.acuitybrands.com   © 2024 Acuity Brands Lighting, Inc.   All rights reserved.   Rev. 09/27/2024

Design Environment (Cont.)
Selection Filters are a way to filter certain types of entities from your selection. Selection filters are available to filter out the following object types when 
trying to select entities in the design: Products, Wires,  Rooms, Background Objects, and Background Images. When a filter is active (highlighted blue) 
objects of that type can be selected. Disabling a filter will prevent you from being able to select those types of objects in the design. This can be helpful 
when trying to select all devices in a project with a window select, or preventing any background images from being accidentally selected while working.

Figure 7: Settings Window

The fastest way to move around your design is to use the mouse. Visual Controls recommends a 3 button mouse. Use your mouse wheel to zoom in and 
out. Press down on the mouse wheel and drag to pan the camera. You may also pan by holding control + right click while dragging.
Double clicking the center mouse in the design environment will perform a zoom all.

You can access the program settings from the File menu. The settings window allows you to customize the look and behavior of Visual Controls, e.g. 
changing the designer background color. In the settings window, you can change to the keyboard tab to customize hot keys for commonly used commands.

Create and save custom connection rules and pre-generated rooms with the Smart Connect and Smart Rooms tabs. Lastly, chose which audit rules are active 
when running the check in the design by selecting or deselecting options on the Audits tab. 
  

The Mouse

Settings
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Typical command

In general Visual Controls allows you either select the objects you are going to work on ahead of time, or start the command, then select them. Select 
objects by left clicking them, then select the move command. Note that once you start the command, it detects you already have objects selected. In the 
status bar at the bottom left of the window displays the command prompt asking you to select a start point. Left click to indicate the start of the move. Now 
the objects are attached to your cursor and you can preview the move. The status bar indicates the current displacement. Left click to indicate where you 
would like to move to, and the objects will be moved.

You can also start the move command before you select entities. If you start the Move command, the status message lets you know that you are in a 
selection step, you can click or window objects you’d like to move. Once you have objects selected, you can right click to end selection and move on to the 
basepoint step.

You can repeat the last command by right clicking when you are in the default select mode or by hitting space bar. You can cancel out of a command by 
hitting the escape key.

Figure 8:Ribbon Bar

Figure 9: Status Bar
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Import

You can import DWG/DXF files, Image Files, or PDFs to use as backgrounds. All import commands are available in the backstage area. You can also use the 
default hot key ctrl+I to import a PDF.

Figure 11 - PDF Import Window

PDF

Figure 10: Import File Menu



10 of 45Acuity Brands | One Lithonia Way Conyers, GA 30012  Phone: 800.535.2465   www.acuitybrands.com   © 2024 Acuity Brands Lighting, Inc.   All rights reserved.   Rev. 09/27/2024

PDF
PDFs and images are imported essentially the same way. At this time, PDFs are converted to a raster images even if they are vector PDFs. Simply select 
import PDF, then select the PDF file. The selected PDF will then be loaded into the import dialog. Here you can select which page to import from multi page 
PDFs.

In the top right you can set a scale factor, this will automatically scale up the PDF. The default value is 96, which is the correct factor to scale a PDF that is 
1’=1/8”.

Using the crop command, you can select just the portion of the PDF or image you want if you do not need the whole image.

When you are happy with the image you are importing, click ok, then select a base point location to insert the image. If you right click it will automatically 
be placed at the origin.

Placed images and PDFs are put on their own layer which you can choose to lock to prevent them from selecting as you work over them. You can also 
prevent them from selecting by using selection filters. Just toggle off the image selection filter.

Figure 12: Design Layers Figure 13: Locked CAD Layers

DWG

Select the import drawing command, this will open a file dialog. Select the dwg or dxf file you’d like to import. The file will then import with its own layer 
group. You can set all of the drawings imported layers to locked by clicking the pencil icon of the layer group, or click again to hide all. If the layer group 
setting is by layer you can apply settings to layers within the group.

Use the layer identify command to find out what layer an entity is on, as well as what else is on the layer. Select identify, then click an entity in the designer. 
The layer of that entity will highlight in the layer manager, and all entities on that layer will highlight in red.

The hide command at the top of the layer manager allows you to select entities in the designer and then hide all entities on that entities layer. Start the 
hide command and then start clicking entities. With each selection, the entities that will be hidden will highlight, right click to confirm your selection and 
adjust the layer’s visibility.

Once you have the sublayers hidden that you do not want to see, lock the top layer group to prevent selecting or editing line work you imported
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Figure 15: Product Selection Window

There are several ways to select ABL products to place in your project, however, you do need an internet connection. Perhaps the easiest is by typing in the 
product catalog into the quick search field in products side bar. The products sidebar is tabbed with the project explorer, if it’s not visible just select the 
Products Tab at the top. In the search field, begin typing a catalog, such as “ncm”. Once 3 characters have been typed, a search will start. You can narrow your 
search by typing more like “10 2p”. The search will check three locations for the intended product; It will check the design to see if the product has already 
been loaded or placed, as well as check the cloud product selection window, and lastly, it will check any saved favorites in the design. When you see the 
catalog you would like, left click the row to begin the place command.
Once a product is selected its information is downloaded from the product database including its symbols and spec sheet. After the symbol loads you can 
begin placing the product. Each left click you make in the design environment will add a new location. You can exit the place command by right clicking or 
hitting the escape key.

Products

Figure 14: Product Search

Quick Search

Selecting from Product Selection Window
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Selecting from Product Selection Window

Auto-Generated Labels

You can open a product selection search window by clicking the magnifying glass icon on the right of the quick search box. Select the desired brand from 
the list of options when opening the product selection window. Once a brand has been selected use the filters on the left to narrow the product types 
available to choose from. Once a product has been chosen, follow the series of drop-down menus to create the necessary configuration. The program will 
inform you of when you have completed the minimum requirements for a product configuration, and limit the selectable options to only create order ready 
configurations. Click Add at the bottom to load the product into your design.

Selected products are automatically assigned a label based on the type of product, e.g., occupancy sensors will typically get the designation ‘OS’ as well as 
a number based on how many OS sensors are already in the project. Whereas power pack products like the npp16 will get the designation starting with ‘PP’ 
etc.

Figure 16: Products Manager

Products that have been added from the Product Selection window will show under the Controls section of the Products Tab. Controls will be listed even if 
they not yet been added to the design. Once a product has been added to the design, the active product count will be displayed next to the product label. 
To the right of the product label is the product symbol, as it appears in the design.

If you wish to place a product you have previously selected, simply pick its row from the Project section to begin placing it again.

From Project
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Select Add Luminaire to open the luminaire creation window. Create generic round or rectangular luminaires or import custom CAD symbols. Luminaires 
can also be assigned embedded sensors  and additional electrical information. Select the magnifying class to view Acuity products that match the selected 
options and assign a product specific catalog number.

Figure 17: Luminaire List

Figure 18: Luminaire Creation Window

Luminaires
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Place in Layout Designer
Most sensor and power pack products are placed with a single click, however, some button stations will automatically switch to be added with a place and 
orient command. So if we select an nWSX product, we first click to enter the basepoint of the product, but then with our next click we can set its orientation. 
You can quickly toggle display of symbols using f10 or the symbols toggle button.

Figure 19: View Tab - Ribbon Bar

Sensor products contain special line work in their blocks to show the extents of the sensors range. You can view sensor patterns by turning them on home 
or view ribbon. There are two available styles. For rings, the closest ring to the product height will be selected. Patterns use the same line work for all 
heights. You can toggle on/off patterns using hot key ‘f5’.

You can also turn on patterns individually. Select a product, then select coverage on. Once you turn on a few patterns, you can now toggle visibility of that 
group separate from the all on / all off toggle.

Figure 20: Coverage Toggle

Place in Layout Designer
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Place in Layout Designer

If you place a sensor within a room, its pattern will automatically be cropped to the outline of the room.

After a product has been placed, via properties you can add a tag to that instance. This is particularly useful for bridge products. For example, you could 
tag a bridge as ‘B1’ and the next as ‘B2’. Instance tags are displayed above the product symbol. Instance tags are particularly useful for identifying specific 
network products, you will see more on this in the connections section.

You can toggle the display of tags and labels under the products dropdown.

You can quickly pick all instances of a product in your design. Simply select 1 instance, and then press the space bar. Once all instances are selected, you 
could change the type using properties, or delete them all.

Figure 21: Sensor Cutoff

Figure 22: Select All Instances
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Place in Layout Designer
You can also select products by selecting them from the Products tab on the Project Explorer. Expand the controls section, then select a 
product by catalog.

By default the color of a product when you place it is determined by the layer setting, which is color by layer, and defaults to blue. You can 
change the layer color mode to be ‘By Entity’ then the color of the blocks will be shown. You can edit block color using the symbol designer. 
You could change the default product color by opening a new project, editing its layer settings, and then saving that project as a template.

Your project schedule can be viewed by selecting the schedule from the project explorer sidebar. The schedule allows you to view and edit the 
controls defined in your project. You can filter what types of products you’d like to see, or from what design. You can also change the sorting 
from by product to by room or by zone.

You can edit a products label, catalog, or description by double clicking into the cell.

You can delete all instances of a product type by selecting the product row and clicking the delete button.

You can duplicate a definition by selecting a row and hitting copy. This will make a new definition that is not related to any existing instances.

Product Schedule

Figure 23: Project Schedule

Figure 24: Schedule Ribbon Bar
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Project Schedule (cont.)
You can edit the connectivity properties of a single product by selecting a row, then selecting Connection Rules button. Typically, you should 
use the default settings and not change the allowed number of children. Once a product can have 1 child, it can also have 1 parent (except for 
system controllers which must be top level). If a product has two ports, it is typically set to allow 1 child control. Similarly, bridges that have 8 
ports, are set to allow 7 children.

You can get the latest product information by selecting a product and hitting the ‘Update Info’ command. This pulls information from the 
product database again to make sure it is current.

You can add notes by selecting the Notes button. These “BOM Notes” will appear on the generated Bill of Materials submittal section.

Figure 26: Symbol Editor

Figure 25: Schedule - Products Tab

If you click the layout symbol of a product row in the schedule the symbol is opened in the symbol designer. In the symbol designer you can edit the look 
of the symbol. For example, you could convert a 1x4 luminaire to a 1x20 to represent a long run of indirect products. Just draw a 1x20 rectangle and erase 
the 1x4 symbol. After you have made your change, select ‘Save Symbol’. The symbol designer will close and anywhere that symbol was used will update.

If you want all of your cat5 to be green instead of blue, you can select the cat 5 symbol, then change the Line color to green and select Close. This will 
change the cat5 product line color which should affect all current and future instances. The benefit of doing it here over a design layer setting, is here you 
only have to change it once, rather than in each design’s layers.

Editing a Control or Luminaire Symbol
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Group
The Group command is used to group objects, symbols, or create new combined catalog nomenclature (Figure 27).

Selection Grouping 

Use the Group command to make for simple selection of multiple objects in a design, or to combine sets of devices into a single interactive 
symbol. From the Group drop-down menu, select “Selection Group”. Left click on the objects you want to group together and then right click 
to close the selection process. Multiple object types can be placed in a group together. Modify commands used on an object in a group will 
apply to all objects in the same group. Individual groups can also be grouped together.  

Symbol Grouping 

The Symbol Grouping command combines any selected device symbols into a singular symbol. Select the devices you want to combine and 
then select the “Symbol” option from the Group drop-down menu. Choose a new name for the group of symbols. A new singular symbol will 
be displayed instead of the individual devices (Figure 28).

Figure 27: Grouping Menu 

Figure 28: Grouped Symbols
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Group (cont.)
Use the copy command to place multiple instances of the group. Edit a group of symbols by selecting the group and choosing an option in 
the properties. “Edit Group” makes changes to the original version of the group and will apply to any new instance placed in the design. “Edit 
Instance” makes changes to a single group and won’t apply to other copies in the design.   

To connect to devices within the group, begin a connection command. When you select the group, a new page will open showing the devices 
within the group. After selecting the connecting device, you will return to the overall design to continue the connection command (Figure 
29).

Catalog Grouping 

Use the “Catalog” option to combine individual devices into a group with a new catalog configuration. To create a Catalog group:

1. Select either the “Catalog Rectangle” or “Catalog Polygon” option from the drop-down menu. 
2. If necessary, adjust the color, line style, and fill style in the properties. 
3. Use the left mouse button drawn a boundary around the devices to be grouped.
4. Enter a new combined catalog nomenclature for the group. 
5. Click OK (Figure 30).

The new nomenclature will be displayed next to the boundary created. You can move this label by dragging it to a new location.

Figure 29: Connecting to the Group

Figure 30: Catalog Group
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Group (cont.)
The new combined catalog group will be added to the Schedule, under the Category type “Group”. Individual components of the group are 
listed underneath. The group can be collapsed or expanded using the arrow to the left of the group name (Figure 31).

Ungroup

Grouped objects, symbols, and catalogs can be ungrouped using the UnGroup command on the Modify tab. Ungrouping a selection group 
will return the objects to an individual interaction. For groups within groups, they will be returned to individual groups when using the 
command. Ungrouping a symbol group will break up the single symbol into its original list of devices. To ungroup a catalog group, either 
delete the boundary and label in the design, or delete the group label in the Schedule. The previously contained devices will be listed 
individually as normal. Ungrouping a group containing other groups will return the BLANK to individual groups.

Figure 31: Catalog Group In Schedule
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Export

You can export from the schedule to Agile’s XML format or to Excel. The Agile xml format can then be uploaded to Agile expedite your quoting process.

Excel export can include or not product images. The excel output will match the current grouping of the schedule designer. If your schedule is grouped by 
room, you can export to excel and get a room by room list of your products to help facilitate SOO checks.

Figure 32: Schedule Export Options

Generic Products

You can add generic products to your design from the Schedule. You can add generic products from 4 product categories, Button Stations, Luminaires, 
Relays, and Sensors. Each generic type comes with a default plan symbol and a default riser symbol. The risers have typical fields associated with each type, 
e.g. Loads on the Generic Relay riser. Generic sensors do not have sensitivity patterns/rings associated with them. All generic types get a default labeling 
designation with an X in it, which you can change.

Figure 33: Adding products from the schedule
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Favorites

Favorite Products allows you to build up a library of commonly used products so that you can quickly insert them into your design without having to search 
for them. Favorites can be organized into groups. You can drag products within or between groups to order them. The number to the left of the favorite is its 
‘hot key id’. You can quickly add an item from favorites to your design by pressing the * symbol on your keyboards numpad, then the number eg 5 on your 
numpad, and enter on your numpad.

Use the Up/Down Arrow Icon to Import a pre-generated list of recommended products into the favorites section. Also use the command to export a custom 
favorites list or clear the current contents.

Figure 34: Favorites Section

To add a product to your favorites, select the product in the schedule and then use the ‘Add to Favorites’ button.
Changes to your favorites are saved when you save your project. To help keep favorites organized, products with the same catalog cannot be added to the 
same group. Group names must be unique, eg you can’t have two groups called ‘Button Stations’.
To remove an item from your favorites, simply right click it and then select remove. You can also use the right click menu to add another group or sort a 
group alphabetically by catalog.
Once you build up a favorite library, you can share it by copying your UserFavorites folder to the desired machine. The favorite folder can typically be found 
here C:\ProgramData\Visual Solutions\UserFavorites. Note that the ProgramData folder is hidden by default. You should be able to navigate to the directory 
by just copying the above folder path into windows explorer.

Figure 35: Favorites Button
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Emergency Products

Figure 36: Spec Sheet Dropdown

Specsheets

If you would like to indicate that a lighting product is for emergency purposes, you can duplicate the non-emergency schedule row and then customize the 
product label. 

Due to some limitations on linking of specsheets to catalogs users may have to select a specific cutsheet for a catalog. To do this, go to the 
schedule, click the text in the spec sheet column, and then select one of the files in the drop down. To prevent repeated effort on your part, we 
save a log of your specsheet selections locally on each users machine so next time you pick that catalog we will automatically try and pick the 
spec sheet file. File selection can also be saved along with any new favorites you create.

Connections

Making connections between products is an important part of your controls design. You can make connections that are represented by a wire, 
or by an arrow and tag. 

Like other commands in Visual Controls, you can pre select before starting the connect command, or start the command and then select. 

In general, when making connections order matters. You should typically not make connections via a window pre select as the connections 
and related line work will be in an undesirable order. 
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Overview

The links you make with the connect commands are stored in a tree structure. Each node can have 1 parent, most nlight controls can only 
have 1 child, but network level controls like nbrg for example can have 7 children (7 child +1 parent = 8 ports). When you click controls to 
connect, you are indicating that the first you selected, comes before the next, which comes before the one after.

The number of children a product allows is visible if you select the product row in the schedule. While this value is editable you should 
typically not edit it.

Select a few controls in order, then hit connect to generate the cat5 wires. If you hit connect again, you will see numbers floating above. These 
indicate the order as well as the depth of the product in the connection structure you are establishing.

Figure 37 - connection path

Figure 38 - connection path

Connect Command

If you start the connect command then begin selection, you have more control over how connection wires are drawn. You can see a preview of the wire as 
you move your mouse between selections. Clicking once in between products allows you to force the connection arc in that direction. If you click more than 
once, you can force the wire to travel more complicated paths.

After a connection is made, it will stay with the product block when the block is moved. Connections should automatically delete or heal when products are 
deleted.

Sometimes you may get a message saying that a connection cannot be made. This may happen if a product already has a parent and child connection and 
cannot make another, or if your connection would make a loop. If you think the connection can be made, try it again reversing your selection order.

If you don’t like quite where a wire is after it’s created, you can click and drag the wire to edit it. While the wires typically take on an Arc appearance, they are 
actually splines, usually with two control points. When you drag to edit, you move the control point nearest where you began your drag.

If you are really struggling with an edit, you can delete the connection and remake it using forcing points between products to adjust the bend.

If you have overlapping lines, you can add a line break using the line break command from the connect drop down. Just select the line to add a break, then 
indicate where.
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Bridge Connections

Figure 39: Network Connection Drop-down

Figure 40: Bridge Connection Properties

Bridge connections create a text tag with a leader instead of a line going all the way to the bridge. To make a bridge connection, you select a network device 
from the drop down, then select the products that will connect to it. You can also select the product or products first, then select the bridge. If you can only 
add as many bridge runs as there are ports available.

It is possible to connect products between designs if your project has more than 1 design. Select the product in 1 design, then select the cross designer 
connect cmd. Then change designs, and select a product to connect to in that design. If you are connecting across design to a bridge, you should just select 
the bridge from the connect drop down.

Cross Design connections

Cross Design connections

The bridge tag either says “BR” + port number indicated as P1, or, if you have supplied a tag for the bridge instance you are selecting, the bridge tag will be 
“[tag] P1”. Tagging bridge inserts is a good practice to get into. Tags are also displayed in the bridge connection dropdown list to help you identify specific 
bridges.
After a bridge tag is placed, you can move the location of the tag using the move command. The leader line will automatically update to the new location.
You can delete a bridge run connection by deleting either the text or leader. Bridge runs are automatically placed on a separate layer from normal cat5 
connections.
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Risers

Risers diagrams can be created manually by right clicking the Riser header and adding a new page. Manually insert riser diagrams using the Risers 
command and selection window on the ribbon bar. Risers can also be automatically generated and updated using the riser generation button on the right 
side of the section header. Choose your riser settings, and page size and format options. With the “Auto Generate Riser Pages” button checked, risers will be 
added and update automatically as you design.

You can include a low voltage or line device as a 1 node offshoot of a cat5 connection run. For example, putting a PP16 shunt via a line voltage connection 
on a power pack for emergency override. To make a line voltage connection, start the connect command, in the command properties (right hand side) select 
the LINE wire type, select the two devices and then right click to create the wire. It’s the same process to make a low voltage connection such as for a LVKS, 
just select the LV wire type. This feature currently only supports LVKS and PP16 SHUNT during riser creation. The riser will only draw the first product of a LV/
LINE offshoot from CAT5.

PP16 Shunt and LVKS

Figure 42 - Riser Diagram

Figure 41 - Riser Generation
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Printing Page Setup

Figure 43:Print Settings

Figure 44: Project Settings

To set the print paper size, go to the backstage by clicking file, then select print. Here you can select set your paper size. Once you set a page size it will be 
applied to all existing and new print pages.

Later on, you can use this tab to preview your print.

Use the Project section from the File Menu to set the basic information that appears on the print page title blocks.
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Printing Page Setup (cont.)

Figure 45:Design Print Page Section

Figure 46:Design Selection Window

Place Drawing

To view and edit a print page, select the page from the project explorer.

In the print designer, the bulk of items you will be placing are in the print tab. The first option is to select what design, if you only have 1 design in your 
project it is already selected.

The print designer ribbon has several commands that place information specific to a design in your project. If you only have one design, then you don’t 
have to worry about. If you have multiple, you can select which design the viewport/risers/legend commands will place. Use the Select Design command to 
open a the design selection window. The selected design will then have its name displayed below the viewport / riser / legend buttons.

To place a view of your layout designer, select place viewport command, then indicate with two left clicks how big you would like the viewport to be on the 
page. While you are in the place drawing command, you will see options in the properties like auto scale which you will typically want on, and convert to 
black and white. Drawing views are automatically kept in sync with changes you make. If you select the drawing after you place it, in properties you can 
adjust its scale or edit the drawing label. If you would not like a label to be drawn, just clear out the Title field.

If you need only part of your layout to show, you can use the crop command. Select the drawing, then the crop command. Now using two left clicks indicate 
the region you would like to be displayed.
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Adding a Riser

Figure 47:Riser Selection

Figure 48:Legend Section

Figure 49:Project Detail Section

Adding a Legend

Adding Notes

You can add riser diagrams for your layout in two ways, by bridge, or by room.

In networked systems, you can also place risers by port. Under the port dropdown you will see a listing of bridges each with a sub menu of ports. Select a 
bridge to place its riser, or select a bridge port to place its riser. Risers will automatically update when you make connection changes in layout.

For systems that are not linked in a network, you will need to add rooms in the layout. Once your layout has rooms, you can then place a riser for each room 
by selecting the room name from the Rooms riser drop down and selecting a location. Adding a room makes it easier to cross reference between your riser 
in print and the location of the products in your layout. If you have repeated rooms, consider naming one room ‘Typical [Room Type]’ to leverage the auto 
generated labels placed below the riser.

Once risers have been placed, they will be grayed out. The page they are on will be indicated next to the item or as a tooltip when you hover over the item.
It may be helpful to turn on coordinate snap to help line up the risers you place.

Product legends show the number of times a product was placed in layout, its symbol, as well as label, catalog and description. Just select the product 
legend button and left click to indicate a location. If you select a legend item you can edit the drawing label, or set a max number of rows to generate a 
multi column legend.

You can place either text based notes or DWG based notes into the print page. Both have built in library of notes you can use. You can select ‘Choose From 
File’ to pick a new DWG note to use that isn’t part of the build in library. Under DWG Note, select Manage Notes, to add a file to your note library for future 
use.
It is possible to load in a folder structure of DWG notes, just copy folder(s) into C:\ProgramData\Visual Controls 2017\Templates\User\CADNotes when you 
reopen Visual controls you should see cad files and sub folders included in the drop down menu.
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The scale commands can be found on the modify ribbon. Select the object(s) you want to scale. Select the Scale command. In the command properties 
(right side bar) adjust the X and Y scale factors. In the design environment, left click to indicate the basepoint for the scale command.

Command Reference

Figure 50: Modify Ribbon Tab

Scale

Select the object(s) you want to scale by reference. Select the Scale by reference command. In the command properties (right side bar) adjust ‘New 
Distance’ to be the length you want your reference segment to be after the command. In the design environment, left click to indicate the basepoint for the 
reference, then left click for the second reference command. The command will then scale the length of the segment of your two clicks to match the ‘New 
Distance’ you entered.

Scale by reference

Figure 51: Stretch Command

The stretch command can be used to edit a vertex or a side of a polygon or line. This allows you to edit lines and rooms you have already drawn without 
recreating them. Select the stretch command and then select the object you would like to stretch. Depending on where you click on the object you will 
either select a side or a vertex. To select a vertex, click close to a vertex. To select a side, pick closer to the middle of a segment. After you have selected your 
edit point, you will then select a basepoint for your move, and a destination point for the move.

Stretch
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Zones

Assign zones in your design using the commands found on the Design tab (Figure 52).

Rectangle/Polygone Zone 

While placing the zone, adjust the name, description, border color, line style, and fill color and percentage in the properties. Select the zone to view 
additional zone properties; adjust Load Type, Watts Override, as well as label style and location. Any products included in a zone will show the zone name in 
the product properties.  

 

Relay Zones 

Turn any Rectangle/Polygon zone into a Relay Zone by selecting the “Is Relay Zone” option from the zone properties. After designating a zone as a relay 
zone, adjust additional information for the Line, Feed, Zone Type, Number of Poles, and whether it will be an emergency zone.  

 

Product Select - Zone 

With the Select command, assign multiple devices to a new zone. With the command initiated, set the zone name and color, and select any devices that 
should be included in the zone. After completing the command, products will individually display the assigned zone on a new label.  

 

DeZone 

Remove a device(s) from a zone using the DeZone command. Select DeZone from the drop-down Select menu and choose any zoned device  to remove it 
from the assigned zone. The DeZone command will only remove devices assigned to zones with the Select command. Devices included in zone boundaries 
will not be removed using the DeZone command.  

Figure 52: Zone Commands
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Audit
Visual Controls can perform an audit to try and catch conditions in your design that may indicate an error. For example, if you have two symbols with the 
same insertion point, you may have accidentally double clicked when placing a product. You can manually run an audit by clicking the refresh button. The 
time that the last audit was run is displayed to the left of the refresh button. If warnings or errors are found, they are listed below. The audit runs on your 
entire design, warnings on other designs are shown with gray text. If a warning is on your current design, it will show with black text. Clicking a warning will 
zoom the design environment to the location of the warning condition.

Type of Audit Warnings,

Not all warnings mean something ‘is wrong’, simply that something ‘could be’ wrong. They should be used as a reference when double checking your work.

• Drawing Audits
• Overlapping Symbols (error)

• Two or more product inserts with the same insertion point
• Unconnected nLight Devices

• When an nlight product is detected with no connections

• Network Audits
• Unconnected runs

• Run not connected to a bridge when there is a bridge in your project
• Isolated Bridge

• Bridge not connected to a nGWY/nECY
• Run Depth

• When a product is more than 128 connections after the last bridge
• Fresco on Network

• When a Fresco Touchscreen is connected to a networked system
• Bus Power (error)

• When bus power is calculated to be insufficient < 3mA 

Bus Power

The calculation looks for devices that add power (npp, nps, npanel) to the bus, then looks up and down the connection structure subtracting bus power for 
each power consumer, typically 3ma. Typically, the resolution for low bus power is either to add a power pack to the middle or the end of the run. While 
bridges do contribute some bus power, as a ‘best practice’ their contribution is not considered in the audit calculation. nLight enabled luminaires can 
contribute 6ma dynamically. However, our initial bus power audit counts their contribution as 3ma up and 3ma down.
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Project Templates
When you start a new project Visual Controls opens the default ‘Blank Project’ template. The blank project has 1 design and 1 print page in it. It is possible 
to save your own templates. You can adjust layer settings, save product schedules, and save print pages in templates. Essentially a template lets you save 
anything you would in a project except revision history.

To create a template, go to the ‘Save As’ pane backstage. Next, check the ‘Save as a project template’ box. Supply a template name, and then click save. Your 
template will now be available on the new pane. A project created from a template will start out with everything the template was saved with.

Templates can be used to store new default layer settings, customized products, print settings and are a great way to tailor your output.

Figure 53: Project Template Save Menu
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Panel Schedule

To create a panel schedule, select a panel device that has been placed in the design and click Panel Schedule on the Design tab. Alternatively, select the 
panel device and click the “Panel Schedule - View” button in the device properties (Figure 55). To begin a new panel schedule, select Create. The type will 
be preselected based on the size and type of panel selected, but this can be adjusted, if necessary, by selecting an alternative type (Figure 56).

Figure 54: Manually Creating Panel Schedules

Manually Creating Panel Schedules

Figure 55: Panel Properties Figure 56: New Panel Schedule 
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Manually Creating Panel Schedules (contd.)

Once a panel schedule is created, information can be adjusted manually for each of the rows , by clicking in the field and typing. New columns, rows, and 
groups can be added and adjusted by using the commands on the ribbon bar. The device symbol and product type will not update based on changes made 
in the Panel Schedule (Figure 57). When adding a new column, choose a name, value type, value range, column width, and field alignment (Figure 58). 

Once a panel schedule is created, information can be adjusted manually for each of the rows by clicking in the field and typing. New columns, rows, and 
groups can be added and adjusted by using the commands on the ribbon bar (Figure 57). When adding a new column, choose a name, value type, value 
range, column width, and field alignment (Figure 58).

Use the Import and Export commands to save and share created Panel Schedules.  Panel schedules are exported as a .CSV format, which can be imported 
into Microsoft Excel, and other spreadsheet software. Import the saved .CSV file to quickly add created Panel Schedules to the design. Panel schedules can 
also be placed in design print pages and then exported as a .DWG, PDF, or printed on the various paper size options

Figure 57: New Column

Figure 58: Panel Schedule Ribbon Bar
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Auto Generate Relay Panel Schedules

Panel Schedules can be automatically generated once relay zones have been added to a design. After placing relay zones, select the “Is Relay Panel” option 
from the zone properties and add any additional relay information needed (Figure 59). For more information on relay zones, refer to the Zones section in 
the table of contents.  

After all zones have been placed in the design, select the “Auto Gen Relay Panels” command from the Automation tab. You will be prompted to save your 
project. After running the command, no prior actions can be reversed using the Undo command. To regenerate the panel schedule, you will first need 
to delete the current panel schedule. In the panel generation menu, make selections for the panel type preference, voltage settings, panel construction 
options, and whether the panels include an internal time clock.  

You can choose to either use existing panels placed in the design, or have the process add new panels automatically by selecting “Delete Pre-Existing 
Panels” at the top of the window. You can also limit the panel options to saved devices in your Favorites by selecting “Use Favorites” (Figure 60).

Once the options have been selected, click OK to generate a panel schedule. After completing the process, the audit panel will activate showing what 
changes have occurred, indicating if new panels were added to the design and for which relay zones. A new Relay Panels section will also be added to the 
Project Explorer, as well as a new Relay Panels print page, detailing the panel(s) added to the design. To view the newly created Panel Schedule, select a 
panel device and click “Panel Schedule” on the Design tab. Alternatively, select the panel device and click the “View Panel Schedule” button in the device 
properties.

Figure 59: Relay Zone Properties

Figure 60: Auto Panel Schedule Generator
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Sequence of Operations

The Sequence of Operations designer allows you to fill out a matrix of space types (rows) and behaviors (columns). There are several default space types 
provided for convenience as well as a standard set of columns. If you select a row, below the grid you can type out (or paste in) a text description.

You can delete a space type by right clicking the row header and selecting ‘Delete Row’. You can add a row by just typing in a new Space type name.

You can add, reorder, and delete columns. Added columns can either be check boxes or text based, eg time fields.

SOO rows can be saved as part of template files. Simply start a blank file, edit the SOO grid to match space types that show up in your region/code set, save 
your SOO changes, then save your project as template (described in 8 Project Templates) and any files created with that template will start with those saved 
SOO space types.

The SOO matrix can be placed onto print pages in the print page designer. If you create a submittal, the SOO descriptions can be included as part of the 
submittal PDF.

Figure 61: Sequence of Operations Manager
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Submittal Generator

From the backstage area you can access the Submittal Generator. The Submittal Generator allows users to create a combined PDF with table of contents and 
cover. Submittals have several predefined pages such as notes, drawings, product information. You can add additional PDF documents by right clicking and 
then selecting Add PDF. You can rename a page, which will change how it appears in the table of contents, but double clicking its name, or right clicking 
and selecting the edit option. Selecting an item will load the appropriate editor to the right of the main list as appropriate. Items with a red X to the right are 
missing information, eg no PDF file selected, and will not be included in the final report.

Changes to your submittal settings are saved when you save your project.

Figure 62: Submittal Generator
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Backup files
We now create a backup file when you save over a project file. A .vcbk file is your vsp file that would have been overwritten. So a .vcbk file is one save behind 
your current .vsp file. To open a .vcbk file, simply change its file extension from .vcbk to .vsp and double click the file to open. 

It is also possible to recover projects from the temporary location they are unzipped into when you open a file. When a file is opened, a temporary directory 
is created, and the .vsp file is unzipped into the temp file. The temp files can be found here C:\ProgramData\Visual Controls 2017\OpenProjects. These files 
represent the state of the file when it was opened. The folders are named P_[Project name]_[random number]. So if you don’t have a .vcbk file, and your 
.vsp file is corrupted or missing, you can go to the OpenProjects directory and attempt to recover from the temp file (if you have opened the file within the 
last 10 days). A temp directory is created for each open of the file. 

To turn a temp directory back into a .vsp file, open the project directory (named P_[Project name]_[random number]) so you see several subfolders, .bin 
files, .xml files ect. Then select all of the files and right click, Send To, Compressed “Zip file”. Then change the created .zip file extension to .vsp.
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Cloud Sync 

With the integration of the Visual Cloud portal, Visual Installer mobile app, and Visual Controls software, users can now save project files to the cloud, 
allowing for multiple users to contribute to a central file and for on-site project management via the Visual Installer mobile app (Figure 63).
Before a user can upload a project to the cloud, the user’s Visual Installer account must be associated with an organization.

1. Download and launch Visual Installer from the iOS App Store or Android Google Play Store.  
2. Create an account or log in to Visual Installer using an existing CLAIRITY+ login.
3. Request access to a Visual Cloud organization by contacting the organization’s admin or VisualSupport@AcuityBrands.com, identifying what 

organization you should be added to, and providing the user account created in Step 2.

Once a user has access to an organization, the user can upload a project to the cloud by following the below steps.  

1. From the Cloud Sync section of the File menu, press the Upload Project button (Figure 64).
2. Select the organization to which you want to upload your project. 
3. Press the Upload Project button.
4. If this is your first attempt to upload a project, you will be prompted to enter your login credentials.  DO NOT USE SSO.  Log in using the username 

and password used to log into Visual Installer.

Visual Controls will then upload project floor plans, product locations, connections, risers, room labels, and other project details from the project’s design 
pages to the cloud.  

Note: Specific, uncleared audit flags can affect data uploads.  Users should resolve issues where room IDs are duplicated, where rooms overlap, or 
“Connection not supported by rules” audits before uploading projects to the cloud.

Uploading Files to the Visual Cloud

Figure 64: Cloud Sync Menu

Figure 63: Cloud Sync Menu
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File Access Using QR Codes
After sites have been added uploaded to the cloud, a site-specific QR code is generated and can be viewed in the Cloud Sync section (Figure 64), the 
project’s title block, or the submittal cover page (Figure 65). The QR code can be scanned via the Visual Installer mobile app, which will then allow the user 
48-hour access to the project’s details that were uploaded to the cloud.  Access can then be extended by scanning the QR code again or by adjusting a user’s 
access expiration via the Visual Cloud portal.

Project QR codes come with an automatic expiration date, which can be extended for up to six months whenever needed. When a QR code expires, its 
appearance remains the same, but access to the associated project data is restricted. Extending the QR code renews access without altering the code itself.

The Status section above the QR code will display “Project Previously Uploaded” if changes have been made in the project that have not been uploaded to 
the cloud. Press the Update Project button to update the cloud record.  “Update Complete” will appear when the file has successfully uploaded.

Figure 65 : Cover Page

Syncing Changes with the Cloud
When changes have been made to the Visual Controls file, users will need to select Update Project from the cloud sync section for the changes to appear in 
the Visual Installer mobile app. Once updated, Visual Installer will reflect any synchronized changes within thirty seconds.

After uploading a project, every time the file is opened in Visual Controls you will be prompted to either continue working on the cloud sync version of the 
project, or you can work on the project as a copy of the original, breaking the cloud connection of the file moving forward.
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Syncing Changes with the Cloud (cont.)

Conflict Generation

Site Notes 

If changes are made simultaneously in the Visual Controls software and the Visual Installer mobile app, you run the risk of creating a conflict. Conflicts can 
occur when changes to a Visual Controls file are saved locally but not yet updated in the cloud while changes are being made in the Visual Installer mobile 
app. In such a case, the next time the project is opened in Visual Controls, the conflict window will have a user choose between keeping the version that was 
saved locally or to keep the version saved in the cloud.  A user will need to choose one or the other for each conflict.

Changes in the Visual Installer mobile app will generate Site Notes in the project file, which are accessible from the left side panel (Figure 67). Notes will 
describe the change that was made, who made the change, and the device or room that was affected (Figure 68).

Continue Working  - clicking this button will synchronize the Visual Controls file with the most recent project record in the Visual™ Cloud -- downloading 
any installation notes, conflicts, and design changes. If you’re opening a design to make adjustments or to iterate due to change orders or addendums, you 
should press Continue Working. This will maintain the design’s connection with the cloud and allow you to save a local copy that contains changes that may 
or may not be synced when you press Update. Changes will not be uploaded to the cloud unless you click the Update button, so a user can have many local 
copies and can press Update using any one of the local copies once the design changes are approved.

Create Copy  - clicking this button will allow a user to disconnect the design from what has been saved in the Visual Cloud. A user will be prompted to save 
their file under a new name after clicking this button, and the internal flag that associates this project with the Visual Cloud will be removed. Create Copy 
is best used when files from a previous design need to be referenced while building a new design but will eventually be deleted.  If the backgrounds and 
product locations are going to be kept, Continue Working should be pressed.

Changes made in the Visual Installer mobile app will be saved immediately in the cloud and are reflected in the Visual Controls file the next time it is 
opened. 

Figure 66: Synchronized Project Notice
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Site Notes (cont.)

Figure 67: Site Notes Panel Figure 68: Site Note

Figure 69: Device Associated Notes Figure 70: Site Notes Filter

Selecting a note from the list will zoom in to focus on the associated device or room and will open the entity’s properties menu. Similarly, selecting a device 
or room in the design will filter the site notes section to only include associated notes (Figure 69).

Use the filter option at the bottom of the Site Notes to limit the types of notes visible on the panel.
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Site Notes (cont.)
With a device or room selected in the design, use the Comment option on the bottom left of the panel to add site notes to the list. Added site notes will 
continue to be associated with the selected device or room. Added site notes are viewable in the Project Notes section of the Visual Installer mobile app.  

Select the Status icon at the top of the panel to view a graphical representation of the changes in the design (Figure 71). Icons representing the changes 
that appear above the Site Note will be displayed on the associated devices in the design.

Figure 71: Site Note Status Icons

Figure 72: Autogenerated Site Note Reference

Auto-generated Site Notes
Auto-generated Site Notes and their associated icons can be found in the table below (Figure 72).

Devices have been moved Devices Added 

Devices have been scanned or assigned 
ID numbers by installer 

Devices Installed    

Devices flagged for review Devices Programmed 

Device installation skipped Devices Grouped 
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Viewing Product ID’s
View Unique Device IDs assigned in the Visual Installer mobile app using the Serials option under the View tab.

Assigned Device ID’s will also show on barcode template pages in submittals and will show on riser diagrams.

Figure 73: Serial Number View Active Figure 74: Riser Diagram

Figure 75: Organization Search

Opening Cloud Synced Files
Once a project is uploaded, other users can locate the file stored in the cloud by using the Cloud Search option on the Open tab to search sites in the current 
organization. Use the Filter box at the top to limit visible sites by keyword. 
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